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FOREWORD  

 

 

The copyright law and international conventions protect the Cab Designer software and its 

User’s Manual. Their reproduction or distribution, either wholly or partly, through any means 

whatsoever, is strictly prohibited. Any person who does not comply with such provisions is 

committing an offence of forgery and is liable to prosecution and can be sentenced under the 

provisions prescribed by the law. 
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1  Cab Designer software 
 

1.1  General Presentation 

 
Cab Designer software provides designers with powerful optimisation and simulation 

capability in Excel or any other Windows-based tool, via a command prompt. 

 

The hybrid optimisation algorithm combines global (Genetic Algorithms) and local (Simplex 

or Nelder-Mead) methods in order to efficiently find the optimal solution from any 

configuration of variables, without getting stuck on a local optimum. 

 

It deals with variables of real, integer, binary, alphanumeric, permutation, combination with 

or without repetition and arrangement types. 

 

It manages possible constraints, by accepting or prohibiting their temporary violation by the 

penalty or interior point method. 

 

It covers all types of optimisation problems including the adjustment of probabilistic models 

using the maximum likelihood method (accelerated reliability or degradation models in 

particular). It then calculates the Fischer matrix in order to be able to estimate asymptotic 

confidence intervals by the WALD method. 

 

Monte Carlo simulation makes it possible to characterize the dispersions generated by random 

variables in the calculation results. 

 

Random variables can be defined according to various probability laws: Beta, Binomial, Chi 

square, Erlang, Exponential, Gamma, Geometric, Gumbel, Hypergeometric, Lognormal, 

Normal, Normal Standard, Pareto, Pearson, Poisson, Student, Triangular, Uniform, Gamma 

Variance, Weibull. 

 

The requested results are in the form of mean, standard deviation, quantiles, probability of 

exceeding a threshold, with the associated distribution curves. 

 

Optimisation can focus on a simulation result, such as a mean value or a quantile Q, with a 

probability α of not being exceeded. 

 

When optimization focuses on a mean value, computational time can be significantly reduced 

by roughly evaluating candidates in a small number of simulations, then more precisely 

through additional simulations, depending on the results obtained. 

 

Cab Designer does not require any special knowledge of mathematics, beyond basic notions, 

and can be used in any field of engineering. 

 

1.2  INSTALLING GENCAB ON HARD DISK 

Please follow instructions shown in manual. 
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1.3  STARTING CAB DESIGNER 

In EXCEL, open Designer.xlam file. 

 

Software's functionalities are then accessible using menu "Optimisation", spreadsheet 

functionalities remaining always available. 

 

 
 

 

Three submenus are then offered: 

• a general menu including help, allowing in particular to obtain the user manual, application 

examples and a button to access different tools.a menu specific to optimisation. 

• a menu specific to the simulation. 
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2  Optimisation 
 

2.1  Principle of optimisation 

 

As illustrated in the following figure, parametric optimisation seeks to find the maximum or 

minimum of a function whose decision variables can be subject to constraints which limit the 

range of variation. 
 

 
 

 

The function can have several local optima and a global optimum. 

 

In addition to the performance function f(x, y…), which constitutes the criterion to minimize or maximize, 

the different constraints can be expressed by as many inequalities of the form Ci(x, y…) ≥ 0. 

 

Variables can be of various types (real, integer, binary, alphanumeric, etc.). 

 

An alphanumeric variable can thus be used to name a class of objects and be able to access a catalog of 

properties in a database. 

 

2.2  Initializing parameters 

 
The "Parameters" command from the "Optimisation" menu allows you to create a table, 

named "DATA", in the active sheet in which the user enters the characteristics of the 

parameters of the function to be optimized. 

 

The following table thus defines five parameters whose name is indicated in the first line, the 

type in the second, the variation range or values k and n, in the two following columns. 

 

The initial value of the parameters can be indicated in the fifth column. 

Local maximum 

Global maximum 
Optimum sought 

Domain prohibited 
by constraints 
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Eight types of parameters are offered via a drop-down menu: 

• Real between min and max values, 

• Integer between min and max values, 

• Binary (0 or 1), 

• Alphanumeric (one value among k from 1 to 9), 

• Permutation (values from 1 to k differently ordered), 

• Combination (k values chosen from n from 1 to 9 without repetition), 

• Repetition (k values chosen from n with possible repetition), 

• Arrangement (k values chosen from n ordered and without repetition). 
•  

2.2  Definition of the criterion and constraints 

 

The "Criteria and Constraints" command from the "Optimisation" menu allows you to create a 

table, named "RESULT", in the active sheet in which the user enters a calculation result, 

specifying whether this result must be maximized or minimized by means of from a drop-

down menu. 

 

 
 

The table allows you to define as many optimisation constraints as you want in the form of 

inequality between two cells. 
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The performance function is then entered into the "Objective" cell based on the criteria and 

constraints, as in the example below. 

 

=IF(F4="Max";1;-1)*E4+F11*IF(D11="Penality";-SUM(MAX(0;F7-D7);MAX(0;F9-

D9));SUM(IF(D7>F7;LOG(D7-F7);-10^9);IF(D9>F9;LOG(D9-F9);-10^9))) 

 

A drop-down menu allows you to indicate whether the violation of constraints is temporarily 

authorized (penalty: penalty method) or prohibited (barrier: interior point method). 

 

 
 

A factor (from 0 to 1015) allows you to adjust the intensity of the penalty or the barrier 

function as follows: 

 

Penalty method:: 

Violation = Nb_constraints
0 min(0, Value – Threshold) 

 

Performance = if (Maximum, 1, -1) * Criterion + Factor * Violation * Loop number / 

Optimisation loop number 

 

Interior point method: 

 

Fonction barrière = Nb_constraints
0  if(Value > Threshold, Log(Value – Threshold), - 

109) 

 

Performance = if (Maximum, 1, -1) * Criterion + Factor * Barrier function  

 

 

2.3  Start of optimisation 

 

The "Optimisation" command in the "Optimisation" menu allows you to launch the 

optimisation after having indicated the number of optimisation loops chosen (Genetic 

Algorithms) as well as that of simplex steps carried out at the end of certain loops, playing 

only on the real parameters only. 
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The simplex may only be performed on a certain percentage of optimization loops. 

 

The value of the parameters can be reset at startup (Reset) or taken from the previous 

calculation, entered in the “Init/End” cell. 

 

The Fischer matrix can be calculated after fitting a probabilistic model by the maximum 

likelihood method ({=Fisher_matrix}). 

 

Many application examples are provided by the "Examples" command in the "General" menu. 

 

Thus, the following mathematical function has many local optima. 

 

 
 

The following example concerns the fitting of a degradation model by the maximum 

likelihood method from wear trajectories of the same type of component. 
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The Fischer matrix makes it possible to estimate asymptotic confidence intervals surrounding 

the 5 parameters of the probabilistic model, by applying the WALD method. 
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3  Simulation 
 

3.1  Principle of Monte-Carlo simulation 

 
Illustrated by the following figure, Monte Carlo simulation consists of simulating a 

configuration of random variables used in a calculation to obtain a result, then repeating the 

operation a large number of times in order to obtain a distribution of the result. The 

calculation can be of any complexity and lead to multiple results. 

 

 
 

Each of the random variables is simulated by randomly drawing a value between 0 and 1, then 

applying the reciprocal of the distribution function (or 1 - F(x)), when it exists, as illustrated 

in the following figure. 

   
 

For example, the operating time of a component not subject to wear is simulated by applying the 

reciprocal function of the exponential law to a random value between 0 and 1, i.e.: 

 

TTF = -LN(RAND())/        

 

 

3.2  Initialization of random variables 

 
The "Variables" command from the "Simulation" menu allows you to create a table, named 

"RANDOM", in the active sheet in which the user enters the characteristics of the random 

variables. 

 

Random variables 

Calculation 

1 

0 

Distribution function 

Xi 
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The following table thus defines 5 variables whose name is indicated in the first row, the type 

of probability law in the second, and the parameters of the laws in the following columns.

 
Twenty laws are offered via a drop-down menu. These laws are, moreover, the subject of 

complementary calculation functions accessible with those of the spreadsheet. 

 

The “Help” button allows you to display the nature of the parameters of the different laws: 

 

 
 

 

3.3  Definition of expected results 

 
The "Outputs" command from the "Simulation" menu allows you to create a table, named 

"SIMULATION_RESULTS", in the active sheet in which the user enters the characteristics 

of the expected results. 

 

The table below thus defines three results whose name is indicated in the first line, the 

possible provision of a graph in the second, and the type of expected result in the third. 
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A drop-down menu allows you to choose the type of expected result: average value, quantile 

standard deviation or probability of exceeding or not exceeding a threshold. 

 

The type of quantile (Q90) or the threshold value must be entered in the “Parameter” line. 

 

3.4  Launching the simulation 

 

The "Simulation" command from the "Simulation" menu allows you to launch the simulation, 

after indicating the chosen number of simulations.  

 

 
 

Check boxes allow you to display the graphs or keep the detailed results at the end of the 

simulations. 

 

For illustration purposes, the following example is one of the application examples offered by 

the “Examples” command in the “General” menu. 
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Formulas for simulating random variables are then entered in the “Value” column of the 

“RANDOM” table. 

 

Likewise, the results requested in the “Output” column of the “SIMULATION_RESULTS” 

table are entered in the “Value” column of this same table. 

 

The corresponding cells then have the name of the variable to which the chosen type of result 

is added, as in the following examples: 

Var_1_Average 

Result_1_Standard_deviation 

Result_2_Quantile  

Result_below_threshold 

  

Launching of a new product

Result : 46192,42   =Number_of_sa les * (Price  - Cost_per_unit) - Launching_cost

RANDOM

Name Launching_cost Price Number_of_sales Cost_per_unit 

Law Triangular Triangular Uniform Normal

Parameter 1 3800 35 200 25

Parameter 2 2000 30 5000 3

Parameter 3 4500 50

Parameter 4

Parameter 5

Value 3781,84 38,17 3619,76 21,82

RESULTS

Name Result Result Result

Chart Yes No No

Output Average Quantile <

Parameter 60 0

Value 32734,79946 35625,8897 0,0285

Risk of loss : 3 %

 

 

?
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4 Coupling between optimisation and simulation 
 
The optimisation can relate to a simulation result, such as an average value or a quantile Q 

having a probability  of not being exceeded. 

 

When a simulation is launched, the name “Monte_Carlo_Simulation = true” is created in the 

corresponding file. 

 

If this same file is used for optimisation, the software detects it and asks the user if they wish 

to be coupled with the simulation and, if so, with what number of simulations per evaluation. 

 

For illustration purposes, the following example is one of the application examples offered by 

the “Examples” command in the “General” menu. 

 

 
 

This example focuses on optimizing an inventory of three product types, whose procurement 

cost and selling price are random variables governed by different probability distributions. 

 

The expected profit is the optimization criterion, and the number of products in stock is 

subject to two constraints. 

 

 
 

The user is asked at the beginning of the process to specify the number of simulations to be 

performed per assessment. 
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In the case of optimization on an average value, the user can also enter a minimum number of 

simulations and a level of risk of inappropriate rejection of candidates if he wishes to use an 

optimized coupling algorithm. 

 

This allows the optimization time to be divided by a number ranging from 15 to 60, 

depending on the problem being addressed and the chosen risk level, in the case of rough 

assessments of 50 simulations followed by assessments of up to 10,000 simulations. 
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5  Additional Tools 
 

The "Tools" command in the "General" menu provides access to various tools. 

 

 

5.1  ASSESSMENT 

 

The "Assessment" option allows you to evaluate a parameter configuration in an optimization 

file by calculation or simulation. 

 

5.2  2D / 3D CURVE 

 

The “Curve” option allows you to plot a 2D or 3D curve of the performance function 

(Objective) as a function of one or two real or integer parameters. 
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5.3  Interface with external application 

 

The “External application” option allows you to create a control interface for external 

applications running under Windows, such as the GRIF software suite (from Total) to ensure 

the best availability of a system based on operating costs, or the free Xfoil software to 

optimize the aerodynamic performance of a profile. 

 

The name: External_Application = 1 is then created in the calculation file. 

 

This functionality allows you to run applications external to the Excel environment and 

retrieve the results during an optimisation or simulation. 

 

It consists of writing or reading text files (.txt, .dat, .bat, etc.), launching files (.bat), executing 

workbook calculations or waiting a certain duration between actions. 

 

These actions are each the subject of a specific column in an interface file and are processed 

sequentially in the order of the column numbers. 

 

The type of action to be performed is entered in the first line of the corresponding column, 

either “Write”, “Read”, “Launch”, “Wait” or “Calculation”. 

 

The "LaunchWait" action allows you to launch an external application and wait until it 

finishes running. 

 

The name of the file to be processed, with its directory path, is entered in the second line of 

the corresponding column. 

 

This second line is used to define the waiting time (in seconds) for the “Wait” action and the 

calculation domain to be executed for the “Calculation” action: “Active” for the active 

worksheet or “All » for the entire workbook. 

 

The following lines will be copied, line by line, from the first line of the text file, during the 

“Write” action, or used to receive data from the text file, line by line, during the “Read” 

action. ". 

 

For illustration purposes, the following example is one of the application examples offered by 

the “Examples” command in the “General” menu. 

 

 
 

Calculation Write Write Write Write Launch Wait Read Calculation

All C:\xfoil\Profil.dat C:\xfoil\commands.bat C:\xfoil\xfoil.bat C:\xfoil\result.txt C:\xfoil\xfoil.bat 5 C:\xfoil\result.txt All

LOAD C:\xfoil\profil.dat del C:\xfoil\result.txt   

1 0.00046242469373101 oper C:\xfoil\xfoil.exe  <  C:\xfoil\commands.bat        XFOIL         Version 6.99

0.95 0.00520122789494036 visc80000   

0.9 0.00956106242194309 0  Calculated polar for:                                                 

0.8 0.0171729438592866 iter   

0.7 0.0233378506000102 100  1 1 Reynolds number fixed          Mach number fixed         

0.6 0.0280502018080061 pacc   

0.5 0.0312018239078455 C:\xfoil\result.txt  xtrf =   1.000 (top)        1.000 (bottom)  

0.4 0.032603984030081  Mach =   0.000     Re =     0.080 e 6     Ncrit =   9.000

0.3 0.0319213337245982 Cl 0.5   

0.25 0.0306435112938461 quit    alpha    CL        CD       CDp       CM     Top_Xtr  Bot_Xtr

0.2 0.0286014398614958   ------ -------- --------- --------- -------- -------- --------

0.15 0.0256317256484147    3.957   0.5000   0.02226   0.01095  -0.0256   0.0515   1.0000

0.1 0.0214299628943723 Xfoil address : https://web.mit.edu/drela/Public/web/xfoil/

0.075 0.0186874111126561

0.05 0.0152864902629786

0.025 0.0107426659450749

-0,1

-0,05

0

0,05

0,1

0 0,2 0,4 0,6 0,8 1

Profil

y dy y' y''
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This example seeks to minimize the drag coefficient (CD) of a profile having a certain lift 

coefficient (CL = 0.5) by playing on two parameters, from the standard symmetrical profile 

Naca 0010. 

 

The first parameter modifies the relative thickness of the profile and the second its curvature. 

 

The xfoil aerodynamic simulation software can thus be coupled to Cab Designer. The 

simulation results are obtained for a profile type and a Reynol number of 80,000 at angles of 

incidence varying from 0 to 10°, with a step of 0.5°. 

 

Available at web.mit.edu/drela/Public/web/xfoil/, the xfoil.exe, pplot.exe and pxplot.exe 

files must first be saved in the “C:\xfoil” directory. 

 

 

The “External interfaces” button in the “Tools” menu allows you to declare a workbook as an 

external interface (by creating the variable External_Interface = True), so that it can be 

controlled by optimisation or simulation tools to evaluate solutions. 

 

In the case of an external application performing Monte Carlo simulations, such as Total's 

GRIF/Moca RP software, the result of the evaluation must be given to a parameter named 

"Result_value" in the spreadsheet, as in the following example accessible via the "Examples" 

menu. 

 

Number of simulations per assessment: 115646

m s

DATA 1 2 3 Available time: 112696,1644 5648,478579

Name Emport_Ariane Emport_Vega Delais_Lancement_Vega Number of satellites launched: 522,189518 10,82436571

Type Integer Integer Real

Min / k 22 1 1488 Mission duration: 131400 hr

Max / n 32 7 10000 Availability: 0,857657263

Init / End 29 7 2385,79

RESULT

Criteria 522,189518 Min Result_value: -522,189518

Constraints Result_standard_deviation: 10,82436571

85,77% >= 85%

Penality Factor: 1,00E+09

Objective -522,189518

GRIF/MOCA-RP
Satellite constellation in six orbital planes

. Number of satellites carried by launcher

. Vega launch time

 
 

This example deals with the deployment and renewal of a constellation of satellites placed on 

6 orbital planes. The optimization focuses on the number of satellites on board per launcher 

and the launch time allowing to minimize the consumption of satellites in orbit while ensuring 

a service availability greater than 85%, with at least 21 operational satellites on each of the 

orbital planes. 

 

 

 

http://web.mit.edu/drela/Public/web/xfoil/


 

 20 

 

 

 

5.4  Coupling with Monte-Carlo simulation  

 

The "Monte Carlo Simulation Optimisation Coupling" option allows you to define a 

calculation file as a simulation file by creating the name: Optimisation_Simulation_Coupling 

= 1. 

 

This option is particularly used with interface files for external applications. 
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OPERATING LICENCE AGREEMENT 
 

OF CAB DESIGNER SOFTWARE PACKAGE 

 

 

ARTICLE 1 : SUBJECT 

 

The purpose of this Agreement is to define the conditions in which the CAB INNOVATION Company grants the customer 

with a non-transferable, non-exclusive and personal right to use the software package referred to as "CAB DESIGNER" and 

whose features are specified in user's manual. 

 

ARTICLE 2 : SCOPE OF THE OPERATING RIGHT 

 

The customer may use the software package on one single computer and on a second one provided that the second computer 

does not operate at the same time as the first one.  The customer can only have one software package copy maintained in a 

safe place as a backup copy. 

 

If this license is regarding a performance on site, the customer may install the package software on a server, while 

scrupulously complying with purchase conditions stated on specific conditions especially defining the maximum number of 

users authorized to use the software package from their terminal and the maximum number of users authorized to use it 

simultaneously. The customer is therefore authorized to perform a number of software package documentation copies equal 

to the maximum number of users allowed to use it.. 

 

CAB INNOVATION will be in a position to perform inspections, either itself or through a specialized entity purposefully 

authorized by CAB INNOVATION, at customer premises to verify if customer has met its requirements : number of software 

package copies used, location of such copies, etc... Parties will agree as regards the practical modalities of performance of 

such inspections so as to disturb minimally customer's activity. 

 

ARTICLE 3 : DELIVERY, INSTALLATION AND RECEPTION 

 

The software package and attached supplies will be delivered to the customer on mail reception date.  The customer installs, 

at its own costs, the software package using relevant manual delivered by CAB INNOVATION. 

The customer performs the inventory and shall inform CAB INNOVATION, within three working days of the delivery, of 

any apparent nonconformity with respect to the order. The customer is liable for any loss or any damage caused to supplies as 

from the delivery. 

 

ARTICLE 4 : TESTING AND GUARANTEE 

 

Guarantee is effective as from the mail delivery date set forth in Article 3 and has a three-month validity. 

During the guarantee validity, if the customer experiences a software package operation trouble, he should inform CAB 

INNOVATION about it, so as to receive any helpful explanations with the purpose of remedying such trouble. If the trouble 

is continuing, the customer will return the C.D. ROM to CAB INNOVATION, at CAB INNOVATION's Head Office, at his 

own expense and with registered mail with acknowledgement of receipt, by specifying exactly the troubles encountered. 

 

Within the three months of reception of consignment set forth in preceding paragraph, CAB INNOVATION will deliver, at 

its own expense, a new product version to the customer. This new version will be benefiting of the same guarantee as 

benefited the first version. 

 

The customer looses the benefit of the guarantee if he does not comply with the instructions manual recommendations, if he 

performs modifications of configuration set forth in Article 2 above without obtaining a prior written consent from CAB 

INNOVATION, or if he performs modifications, additions, corrections, etc... on software package, even with the support 

from a specialized service company, without obtaining a prior written consent from CAB INNOVATION. 

 

ARTICLE 5 : PROPERTY RIGHT 

 

CAB INNOVATION declares to be holding all the rights provided for by the intellectual property code for CAB DESIGNER 

package software and its documentation. 

 

As this operating-right granting generates no property-right transfer, the customer abstains from : 

- any CAB DESIGNER software package reproduction, whether it is wholly or partly carried out, whatever the form 

assumed, excepting the number of copies authorized in Article 2 ; 

- any CAB DESIGNER software package transcription in any other language than that provided for in this Agreement (see 

Appendix), any adaptation to use it in other equipment or with other basic software packages de base than those provided for 

in this Agreement. 

 

To ensure this property protection, the customer undertakes especially to  
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- maintain clearly visible any property and copyright specifications that CAB INNOVATION would have affixed on 

programs, supporting material and documentation ; 

- assume with respect to his staff and any external person any helpful information and prevention step. 

 

ARTICLE 6 : USING SOURCES 

 

Any CAB DESIGNER software package modification, transcription and, as a general rule, any operation requiring the use of 

sources and their documentation are exclusively reserved for CAB INNOVATION. 

The customer holds the right to get the information required for the software package interoperability with other softwares he 

is using, under the conditions provided for in the intellectual property code. 

In each case, an amendment of these provisions will set out the price, time limits and general terms of performance thereof. 

 

ARTICLE 7 : LIABILITY 

 

The customer is liable for : 

- choosing CAB DESIGNER software package, its adequacy with his requirements, precautions to be assumed and back-up 

files to be made for his operation, his staff qualification, as he received from CAB INNOVATION recommendations and 

information required upon its operating conditions and limits of its performances set forth in user's manual; 

- the use made for results he obtains. 

 

CAB INNOVATION is liable for the software package conformity with his documentation. The customer shall prove any 

possible non-conformity. 

CAB INNOVATION does not assume any whatsoever guarantee, whether explicit or implicit, relating to the software 

package, manuals, attached documentation or any supporting item or material provided and, especially, any guarantee for 

marketing of any products relating to software package or for using software package for a determined use, any guarantee for 

absence of forgery, etc... 

Under no circumstances CAB INNOVATION could be held responsible for any whatsoever damage, especially loss in 

performance, data loss or any other financial loss resulting from the use or impossibility to use the CAB DESIGNER 

software package, even if CAB INNOVATION was told about the possibility of such damage. 

In the event where CAB INNOVATION liability is retained, it is expressly agreed upon that the total amount of 

compensation to be paid by CAB INNOVATION, all cases taken together, could not in any way exceed the initial-royalty 

price reduced by 25 % per period of twelve months elapsed as from the mailing delivery date. 

 

ARTICLE 8 : DURATION 

 

This Agreement is entered into for an undetermined period of time as of the date set forth in Article 3. 

 

ARTICLE 9 : TERMINATION 

 

Each party may terminate this Agreement, by registered mail with acknowledgement of receipt forwarded to the other party, 

for any breach by such party of its obligations, despite a notice remaining unresponsive for 15 days, and this occurring with 

no prejudice to damages it could claim and provided that the last paragraph of Article 7 above, be enforced. 

 

At end of this Agreement or in case of termination for whatsoever reason, the customer will have to stop using CAB 

DESIGNER software package, pay all sums remaining due on date of termination and return all elements composing the 

software package (computer programs, documentation, etc ... ) without maintaining any copy of it. 

 

ARTICLE 10 : ROYALTY 

 

As a payment for the operating-right concession, the customer pays CAB INNOVATION an initial  royalty the amount of 

which is determined in specific conditions. 

 

ARTICLE 11 : PROHIBITED TRANFER 

 

The customer refrains from transferring the software package operating right granted personally to him by these provisions.  

The customer also abstains from making documentation and supporting material (CD ROM), even free of charge, available to 

a person not expressly set forth in second paragraph of Article 2. 

 

ARTICLE 12 : ADDITIONAL SERVICES 

 

Any additional services will be subject to an amendment of these provisions, possibly through an exchange of letters, so as to 

specify the contents, modalities of achievement and the price. 

 

ARTICLE 13 : CORRECTIVE AND PREVENTIVE MAINTENANCE  

 

The corrective and preventive maintenance may be subject, upon customer's request, to a separate Agreement attached to 

these provisions. 
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ARTICLE 14 : ENTIRETY OF THE AGREEMENT 

 

The user's manual defining the CAB DESIGNER software package features is appended to these provisions. 

The provisions of this Agreement and his Appendix express the entirety of the Agreement entered into between the parties.  

They are prevailing among any proposition, exchange of letters preceding its signing up, together with any other provision 

stated in documents exchanged between the parties and relating to the Agreement's subject matter. 

If any whatsoever clause of this Agreement is null and void with respect to a rule of Law or a Law in force, it will considered 

as not being written though not involving the Agreement's nullity. 

 

ARTICLE 15 : ADVERTISING 

 

CAB INNOVATION could mention the customer in its business references as a CAB DESIGNER software package user. 

 

ARTICLE 16 : CONFIDENTIALITY 

 

Each party undertakes not to disclose any kind of documents or information about the other party that it would have been 

informed of on the Agreement's performance and undertakes to have such obligation fulfilled by the persons it is liable for 

 

ARTICLE 17 : AGREEMENT'S LANGUAGE 

 

This Agreement is entered into and drawn up in the French language. 

In the event where it is translated into one or more foreign languages, only the French text will be deemed authentic in case 

of any dispute between the parties. 

 

ARTICLE 18 : APPLICABLE LAW - DISPUTES 

 

The French Law governs this Agreement. 

In the event of any disagreement over the interpretation and performance of any whatsoever provision of this Agreement, and 

if parties fail to reach an agreement under an arbitration procedure, only Toulouse’s Courts will be competent to settle the 

dispute, despite the plurality of defendants or the appeal for guarantee. 

 

 

 

 
 


